Osnove AutoCAD-a

I z ovih pet poglavlja naucicete sve Sto treba da biste poceli da
crtate u AutoCAD-u. Pocetniku su ova poglavlja neophodna,
ali ¢e i iskusniji korisnici u njima pronaci mnogo prakti¢nih
saveta, posebno u vezi sa osobinama koje se u AutoCAD-u 2004
pojavljuju prvi put. Ako pak mislite da ne treba da Citate ovaj
deo, ipak ga prelistajte i zadrZite se samo na tekstu uz slicice
»,Nova osobina“ kako biste se upoznali s novinama u ovoj verziji
programa.
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POGLAVLIJE

Pocinjemo da crtamo -

U Genje AutoCAD-a pomalo podseca na drevno pitanije: ,Sta je

starije, kokoska ili jaje?* Pre nego Sto poCnete da crtate, . . . .
morate imati izvesne osnove, a osnove AutoCAD-a je tesko razu-
meti ukoliko vec niste nesto crtali pomocu racunara. U ovom U ovom poglavliu
poglavlju razreSicete pomenutu nedoumicu tako Sto cete u
AutoCAD-u nacrtati jedan pravougaonik. U sledecih nekoliko Upoznavanje

poglavlja dobicete dovoljno objasnjenja, pa ¢ete nacrtati i nesto sa AutoCAD-om

sloZenije. Kada odmah na pocetku ,udete” u postupak crtanja,

dalje ucenje ce teci lakse i glatkije. Pokretanje AutoCAD-a

. Otvaranje novog crteza
Upoznavanje sa AutoCAD-om J6 TIOYOR €S2

AutoCAD firme Autodesk najcesce je koriS¢en program za teh- AutoCAD-ov interfejs

nicko crtanje — registrovano je viSe od 3 miliona njegovih kori-

snika. Medu kompanijama koje proizvode softver za personalne Izrada prvog crtea

racunare, Autodesk je na Cetvrtom mestu u svetu po veli€ini.

Prema Autodesku, akronim CAD oznacava projektovanje pomocu Snimanije crteza

racunara (engl. computer-aided design), ali moze da znaci i crtanje

pomocu racunara (engl. computer-aided drafting ili drawing). Zatvaranje crteza
AutoCAD, u verziji za DOS, pojavio se 1982. godine. Bio je to i izlazak iz programa

prvi znacajniji CAD program koji je mogao da radi na personalnim
racunarima. U to vreme je vecina programa za tehnicko crtanje
radila na moénim radnim stanicama ili ¢ak na velikim racunarima
(engl. mainframe). Uspeh AutoCAD-a se pripisuje njegovoj Cuve-
noj otvorenoj arhitekturi — veliki deo njegovog izvornog koda
predstavlja obican (ASCII) tekst koji korisnik lako moZe da prila-
godi svojim potrebama. Podrska programskom jeziku AutoLISP,
a sada i jeziku Visual Basic for Applications (VBA), ugradena je da
bi korisnik mogao da programira AutoCAD.

Zbog svega toga, AutoCAD je postao najfleksibilniji program
za crtanje, primenljiv u svim oblastima rada. Pored engleskog,
AutoCad podrZzava mnoge druge jezike, ukljucujudi i pojedina
nelatinicna pisma, tako da AutoCAD gotovo da nema ozbiljne
konkurencije. Dovoljno je rec¢i da se AutoCAD koristi u svim
oblastima crtanja, u viSe od 150 zemalja.

Brizljivo negujudi inovatorstvo i profesionalizam, Autodesk je
napravio program neprevazidenih osobina i mogucnosti, koje,
izmedu ostalog, obuhvataju prostorno modelovanje i vizueliza-
ciju, realisticno predstavljanje povrsina i tela, pristupanje spolj-
nim bazama podataka, inteligentno kotiranje, uvoZenje i izvoZenje
datoteka u drugim formatima, podrsku Internetu, i jo§ mnogo
toga.

¢ ¢ ¢ ¢
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4 Deo | ¢ Osnove AutoCAD-a

Glavne oblasti u kojima se koristi AutoCAD jesu:

arhitektura, inZenjering i gradevinarstvo (AEC)
masinstvo

geografski informacioni sistemi (GIS)
ispitivanje terena i gradevinarstvo

odrzavanje objekata
elektrotehnika/elektronika

® 6 6 6 0 0 o

multimedija.

AutoCAD se koristi i u drugim, manje poznatim oblastima, kao §to su pravljenje
uzoraka za tkanine, izrada znakova i sli¢no.

Trudila sam se da u ovoj knjizi prikazem primere iz razlicitih oblasti rada. Svet
AutoCAD-a je veoma prostran i vredi upoznati mnoge primene ovog programa.

Pokretanje AutoCAD-a
U ovom odeljku dajemo kratak pregled AutoCAD-a kako biste shvatili njegove
osnovne komponente. Prvi korak je pokretanje programa.

Na CP-u Na kompakt disku se nalazi tridesetodnevna probna verzija AutoCAD-a 2004. Naci Cete je
o u direktorijumu \Software\AutoCAD 2004\setup.exe.

U knjizi objasnjavam rad AutoCAD-a pod Windowsom ME, 2000 i NT 4.0 ili Win-
dowsom XP/XP Professional. Posto je svaki racunar drugacije konfigurisan, mozda
Cete naredne veZbe morati malo da prilagodite svom sistemu. Ako AutoCAD niste
licno instalirali i ne snalazite se u direktorijumima na racunaru, potraZite pomoc¢ od
iskusnijeg korisnika CAD-a.

Referenca Ako imate problema sa instaliranjem AutoCAD-a, pogledajte dodatak A na CD-u.

Podrazumeva se da instaliranjem AutoCAD-a dobijate i precicu do programa
na radnoj povrsini (slika 1-1). Program pokrecete kad dvaput pritisnete sli¢icu pre-
Cice. Isto tako, moZete odabrati Start => Programs => Autodesk = AutoCAD 2004 =>

AutoCAD 2004.
Slika 1-1: Pomocu precice na radnoj povrsini,
- i) jednostavno otvarate AutoCAD.
eS|

AutoCAD 2004

Otvaranje novog crteia
Posto pokrenete AutoCAD, automatski otvarate nov crtez Drawingl.dwg. Ime crteza
se nalazi na naslovnoj traci (slika 1-2). MoZete poceti da crtate. U poglavlju 2 obja-
snic¢u kako da zapocCnete crteZ na osnovu postojeceg Sablona crteZa i kako da otvo-
rite postojeci crtez.

Veiba: pokretanje AutoCAD-a

1. Na paleti poslova pritisnite dugme Start.

2. [zaberite Programs = Autodesk &> AutoCAD 2004 => AutoCAD 2004.
Ugledacete prazan crteZ pod imenom Drawingl.dwg.
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Poglavlje 1 ¢ Pocinjemo da crtamo

Ako nastavljate da pratite ovo poglavlje, neka ovaj crtez ostane otvoren.
Napustanje AutoCAD-a je objasnjeno kasnije u ovom poglavlju.

Interfejs AutoCAD-a

Verovatno jedva cekate da pocCnete da crtate. Najbolje je da se prvo upoznamo sa

okolinom.

Na slici 1-2 prikazan je izgled ekrana AutoCAD-a odmah po pokretanju programa.
Prikaz na vaSem ekranu moZe se donekle razlikovati jer AutoCAD mozZze biti podeSen

na razne nacine, ali su opSte karakteristike iste.

Paleta alatki za
crtanje (Draw)

Paleta
Object Properties | Dugme za minimiziranje prozora aplikacije

Paleta Styles

Paleta Layers Standardna paleta alatki
Linija menija | Naslovna traka
b e S S S R————
- v T Il. o

Kartice Layout

Kartica Model

lkonica korisnickog koordinatnog sistema (UCS)

Statusna traka

=

Konéanica

Komandna linija PovrSina za crtanje

Slika 1-2: Izgled ekrana u AutoCAD-u.
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Dugme za zatvaranje aplikacije

Dugme za maksimiranje prozora aplikacije

Dugme za minimiziranje crteza

Dugme za maksimiranje crteza

Kvadrati¢ za izbor
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Dugme za zatvaranje crteZa

Paleta alatki
za modifikovanje
objekata (Modify)

Meni statusne trake
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MoZete videti i prozor Tool Palettes s primerima kancelarijskog namestaja i Srafurama.
Paleta predstavlja nacin pristupa sadrZaju kojim Zelite da ispunite crtez. O prozoru Tools
Palettes viSe reci ¢e biti u poglavlju 26. Za sad, mozete pritisnuti dugme za zatvaranje pro-
zora kako biste ga sklonili da vam ne smeta. (Ako Zelite da prikaZete ovaj prozor, izaberite
Tools => Tool Palettes Window).

Prozor AutoCAD-a sadrZi Cetiri vazna podrucja o kojima govorimo u narednim
odeljcima.

Povrsina za crtanje

Prazan sredis$nji deo ekrana je povrsina za crtanje, nazvana graficki prozor. Upore-
dite ga s tabakom papira za crtanje. Ovaj ,tabak“ moZe da bude bilo koje veli¢ine
— Cak kao ogromna fabrika!

Pri dnu povrSine za crtanje nalazi se jezicak lista Model. Na ovom listu crtate.
Listove Layout koristite da biste crteZ pripremili za Stampanje na ploteru.

Kada zapocinjete crteZ, zadajte poCetnu tacku za crtanje. Jedan od nacina na koji
ovo moZete da uradite jeste zadavanje koordinata. Po prihvacenoj konvenciji, kada
zadajete tacku, prvo unosite X koordinatu, zatim Y, a vrednosti odvajate zarezom.
Slika 1-3 prikazuje nekoliko tacaka sa odgovarajuc¢im parovima koordinata.

Y osa
%5 ——= R
l
T I : 3,2
00 —;----l-‘l I - . X osa
. g W 6,-2
L] £ — - '
4 k L4 .|

Slika 1-3: Nekoliko tacaka sa odgovarajucim parovima koordinata X i Y.

Poglavlje 4 je posvecéeno razli¢itim nacinima zadavanja koordinata. Da biste odredili tacku
u trodimenzionalnim modelima, morate da zadate i koordinatu Z. Trodimenzionalne koor-
dinate su objasnjene u poglavlju 21.

lkonica UCS

Obratite paznju na dve strelice u donjem levom uglu povrsine za crtanje (slika 1-2).
Taj simbol se zove ikonica UCS (User Coordinate System, korisnicki koordinatni
sistem). Strelice ukazuju na pozitivan smer X, odnosno Y ose.

Izgled ove ikonice mozete izmeniti (pogledajte poglavlje 8).
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Poglavlje 1 ¢ Pocinjemo da crtamo 7

Koncanice

Na povrsini za crtanje na slici 1-2 pronadite dve ukrstene linije s malim kvadratom u
preseku. Ovaj simbol se naziva kvadratic za izbor (engl. pickbox) jer vam pomaze da
odaberete objekte. Ukrstene linije nazivaju se koncanice (engl. crosshairs) i poka-
zuju polozZaj kursora u odnosu na druge objekte crteza.

Pokretanjem miSa istovremeno se pokrecu i kvadratic za izbor i koncanice. U
dnu ekrana, na levoj strani statusne trake (koju ¢emo opisati kasnije), videcete kako
se pri tom menjaju vrednosti koordinata XiY.

Meniji i palete alatki

U vrhu ekrana se nalazi naslovna traka, a neposredno ispod nje linija menija. Ispod
njih su smestene dve palete alatki, standardna paleta (Standard) i paleta sa svoj-
stvima objekata (Object Properties). U prozoru se nalaze jos dve palete: paleta alatki
za crtanje (Draw) i paleta alatki za modifikovanje objekata (Modify), koje su vero-
vatno usidrene uz levu ili desnu ivicu ekrana (slika 1-2). Pomocu ovih menija i paleta,
AutoCAD-u moZete da zadajete komande za crtanje, uredivanje crteza, dobijanje
podataka i sl.

Buducdi da menije i palete alatki moZete prilagodavati svojim potrebama, mozda
¢e oni na vaSem ekranu izgledati malo drugacije. AutoCAD ima jo§ mnogo paleta koje
moZete da prikaZete po potrebi. Medu njima su i palete za kotiranje (Dimension),
za puna tela (Solids), za realisti¢no prikazivanje objekata (Render) i za rad s Webom
(Web). O svemu tome, a i 0 mnogo ¢emu drugom, kasnije cete viSe saznati.

Komandna linija

Pri dnu ekrana je poseban prozor u kome se obicno vide tri reda teksta. (Broj redova
moZete podesiti povlaCenjem gornje ivice prozora navise ili naniZe.) Uocite u njemu
re€ Command:. Ovo je komandna linija ili komandni prozor. Komande pokrecete tako
Sto ih upiSete na komandnu liniju.

Kada za pokretanje odredene komande upotrebite stavku iz menija ili dugme
na paleti alatki, na komandnoj liniji obavezno pogledajte kako AutoCAD reaguje.
AutoCAD cesto nudi opcije koje se biraju upisom preko tastature. Sve Sto otkucate
na tastaturi pojavice se i na komandnoj liniji. Na primer, kada na tastaturi otkucate
koordinate tacke, one ce se pojaviti na komandnoj liniji. Da biste videli sve Sto
sadrZi komandna linija, pritisnite taster F2, pri ¢emu ¢e se otvoriti AutoCAD-ov pro-
zor Text. U njemu moZete da pregledate prethodno unesene komande. Da biste ovaj
prozor zatvorili, ponovo pritisnite taster F2.

Statusna traka

Statusna traka se nalazi u samom dnu ekrana (slika 1-2). Na njenoj levoj strani

ispisuju se vrednosti koordinata X i Y. Kada pokrecete miSa, njihove vrednosti
se menjaju. (Ako se to ne dogodi, pritisnite ih, a zatim ponovo pokrenite misa.)
Na statusnoj traci nalazi se i nekoliko dugmadi o kojima ¢emo kasnije govoriti.

S desne strane statusne trake nalazi se mala strelica nadole. Kad je pritisnete miSem, otva-
rate meni statusne trake. Ovaj meni utvrduje koja ¢e se dugmad nalaziti na statusnoj traci.
Ako odredeno dugme ne koristite, odaberite ga na listi, skinite znak potvrde ispred njega i
uklonicete ga sa statusne trake. Uvek se mozZete ponovo vratiti na listu i potvrditi ga ako
Zelite da bude prikazano. Sa desne strane statusne trake nalazi se i ikonica Communication
Center. Detalje o njoj naci ¢ete u poglavlju 26.
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Komandu FULLSCREEN alatki Express zadajte da biste sakrili naslovnu traku, meni i sta-
tusnu traku. Tako dobijate veci prostor za crtanje. Da biste se vratili u standardni prikaz,
upisite fullscreen na komandnoj liniji i pritisnite taster Enter. U dodatku A na CD-u nadi
cete viSe informacija o instaliranju alatki Express.

Vas prvi crtez

Gotovo da ste spremni da povucete prvu liniju. ZadrZimo se jos malo, da objasnimo
kako cete AutoCAD-u zadavati komande pomocu paleta alatki.

Savet

Palete alatki

Postavite kursor na prvo dugme na paleti alatki za crtanje. Ugledacete malen okvir
s tekstom (ekransku pomoc) u kome pise Line (linija) (slika 1-5). I na statusnoj traci
¢e se pojaviti obavestenje da to dugme sluZzi za crtanje pravolinijskih segmenata.

T
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Slika 1-4: Kada postavite kursor na
dugme Line, pojavice se kratak opis
njegove funkcije.

Ako sluajno pokrenete komandu koju niste Zeleli, samo pritisnite taster Esc. U komandni
prozor ¢e se odmah vratiti AutoCAD-ov zahtev za unos Command:.
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Poglavlje 1 ¢ Pocinjemo da crtamo )

Crtanje pravougaonika
U ovoj vezbi samo tac¢no sledite uputstva. Kada unosite koordinate X i Y (prikazane
polucrno), upisite prvi broj, zatim zarez, pa drugi broj — sve bez razmaka. Ako niste
procitali uvod, vratite se i procitajte deo koji se odnosi na izvodenje vezbi. Ne bri-
nite ako ne budete sve razumeli. Dok budete radili uz ovu knjigu, sve ¢e vam postati
jasnije.

Pratite dolenavedene zahteve za unos. Kao sto je u uvodu objasnjeno, ono sto
treba da unesete, bice ispisano polucrno. Uputstva u odeljku s komandama bice
ispisana kurzivom.

Veizba: crtanje pravougaonika
1. Pokrenite AutoCAD.
AutoCAD prikazuje novi crtez. (Ako se od vas traZi da navedete Sablon, upi-
Site ili izaberite acad.dwt).
2. Na paleti alatki Draw odaberite dugme Line levim tasterom misa (tasterom
/ za izbor). Na komandnoj liniji ¢e se pojaviti ime komande.

Command: 1ine Specify first point: (zadajte prvu tacku) 0,0 O (Ova
strelica znali da treba da pritisnete taster Enter)

Specify next point or [Undo]: (zadajte sledecu tacku ili izvr3ite
komandu Undo) 10,0 O

Specify next point or [Undo]: 10,7 O

Specify next point or [Close/Undo]: 0,7 O

Specify next point or [Close/Undo]: 0,0 O

Specify next point or [Close/Undo]: O

Na komandnoj liniji ponovo ¢e se pojaviti zahtev za unos nove komande.

3. Da bi vas pravougaonik ispunio celu povrsinu za crtanje, iz sledeceg teksta
unesite ono Sto je ispisano polucrno:

Command: zoom [J

Specify corner of window, enter a scale factor (nX or nXP), or [A11/
Center/Dynamic/Extents/Previous/Scale/Window] <real time>: e [J
(zadajte ugao prozora, unesite razmeru... ili izvr3ite komandu...)

Pravougaonik se nalazi u sredistu povrsine za crtanje i ispunjava njen najveci deo — gotovo
. do ivica. Komanda ZOOM uz opciju Extents (e) $iri crtez do ivice povrsine za crtanje.
p_— 0O komandi ZOOM ¢ete vise nauciti u poglavlju 8.

Referenca

4. Neka vas crtez bude otvoren. Kasnije ¢ete ga i snimiti. On treba da odgovara
pravougaoniku na slici 1-5.

Mozda se pitate u kakvim smo jedinicama zadali koordinate. Zasad smatrajte da
suuin€ima (1 in€ = 2,54 cm), ali moZete zadati i druge jedinice. CrtezZ pravougao-
nika, dakle, moZete odStampati u dimenzijama: 10 in¢a x 7 inca.

Dosad ste naucili nekoliko stvari: kako da zapocnete seriju komandi sluzeci se
paletom alatki (komanda LINE), kako da u komandni prozor unesete koordinate X
i Y i kako da komandu LINE zavrsite (pritiskajuci taster Enter bez upisivanja koordi-
nata). Upotrebili ste i komandu ZOOM upisujuci je u komandni prozor. Veci deo
AutoCAD-a zasniva se na ovim osnovnim radnjama.
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Slika 1-5: Vas prvi crtez.

Ako vas crtez ne li¢i na onaj sa slike 1-5, za to mozZe postojati vise uzroka. Pokusajte sledece:

¢ Mozda ste negde pogresili. Ako mislite da je to u pitanju, onda izaberite komandu File =
New da biste otvorili nov crtez, a zatim $ablon acad.dwt i pritisnite Open. Zatim ponovo
unesite podatke u komandni prozor odgovarajuci na zahteve za unos.

& Ako vas crtez i dalje ne odgovara, onda u CD jedinicu ra¢unara stavite kompakt disk koji
ste dobili uz ovu knjigu. Odaberite komandu File => Open i pomocu okvira za dijalog
Open, na disku pronadite datoteku ab-acad.dwg. Odaberite je i pritisnite Open. Zatim
ponovo unesite podatke u komandni prozor odgovarajuci na zahteve za unos.

Problem bi trebalo da resite ako sledite jedan od dva gornja saveta. Ako ste zapoceli vise
novih crteza, verovatno su svi jo3 uvek otvoreni. MoZete prelaziti iz jednog crteza u drugi bira-
judi ih iz menija Window.

Snimanje crteza
Snimanje crteZa je isto Sto i snimanje bilo koje datoteke u Windowsu. Steknite naviku
da crtez snimate svakih 10-15 minuta da ne biste ostali bez svog remek-dela ukoliko
sistem padne.

Ukoliko veZbate uz ovu knjigu, napravite poseban direktorijum za svoje crteze
kako se ne bi mesali s drugim crteZzima. lako je snimanje standardna Windowsova
funkcija, ovde ¢u ga detaljno opisati zbog njegove vaznosti.

U narednom uputstvu, ostavljam vam na volju da izaberete gde ¢ete smestiti svoj
direktorijum, jer je svaki racunar drugacije organizovan. Ako niste sigurni Sta da ura-
dite, onda odaberite disk (ne direktorijum) na kome je instaliran AutoCAD i na njemu
napravite nov direktorijum. Ne preporucujem da napravite poddirektorijum direkto-
rijuma u kome se nalazi AutoCAD (koji se standardno zove AutoCAD2004), jer postoji
opasnost da pogresite i nehotice obriSete neophodne AutoCAD-ove datoteke.
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Poglavlje 1 ¢ Pocinjemo da crtamo 11

Veiba: pravljenje novog direktorijuma

1. Dovedite kursor na paletu poslova i na njoj desnim tasterom miSa pritisnite
dugme Start.

2. Odaberite stavku Explorer.

3. Ulevom oknu Windows Explorera pritisnite disk jedinicu u kojoj Zelite da

napravite novi direktorijum. Ako ne moZete da se odlucite, odaberite disk
na kome je instaliran AutoCAD. Kad radite na mreZi, odaberite jedinicu koja
predstavlja vas raCunar.

4. Ako Zelite da napravite poddirektorijum, odaberite direktorijum u kome cete

ga napraviti.

5. Iz menija Explorera odaberite komandu File &> New = Folder.

U desnom oknu ce se pojaviti nov, istaknut direktorijum New Folder. Mozda
cete morati da premotate sadrZaj okna da biste ga videli.

6. Kao ime novog direktorijuma upiSite AutoCAD Biblija i pritisnite Enter. (Ako

ste uradili vezbe iz prethodnog izdanja ove knjige, AutoCAD 2002 Biblija, i ve¢
imate direktorijum pod imenom AutoCAD Bib1ija na svom raCunaru, prome-
nite ime prvobitnog direktorijuma u, recimo, ACAD2002Bib11ja.)

Sada moZete da snimite crtez. Ako to Cinite prvi put, postupak podrazumeva
i dodeljivanje imena. Vazno je da ga snimite na odgovarajuci disk i u odgovarajuci

dire

ktorijum. CrteZ bi trebalo da snimite (kao i sve crteze koje budete radili dok

Citate ovu knjigu) u poseban direktorijum koji ste u prethodnoj vezbi napravili.

Upozorenje Pre nego $to predete na ostale vezbe iz ove knjige, neophodno je da napravite direktorijum

Z

a ¢uvanije svojih crteza, kao sto je objasnjeno u prethodnoj vezbi.

H

Da biste snimili crtez, pritisnite na paleti Standard opciju Save. Ako po prvi
put snimate crteZ, pojavice se okvir za dijalog Save Drawing As (slika 1-6).

[1 Bari Brgudivg B AEE
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Slika 1-6: Okvir za dijalog Save Drawing As.
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Duz leve strane okvira za dijalog nalazi se nekoliko dugmadi koja ¢e vam pomoc¢i
da brzo pronadete mesto na kome cete snimiti crteze. Koristite ih na sledeci nacin:

*
L 4

Lista History sadrzi precice do skoro koriS¢enih crteza.

Pritiskom na My Documents dobijate listu crteZa i direktorijuma u direktori-
jumu My Documents. Neki ljudi vole da snimaju datoteke u ovaj direktorijum.
(On se na vaSem racunaru moze zvati i Personal).

U direktorijumu Favorites nalaze se datoteke i direktorijumi u omotnici
C:\Documents and Settings\[korisnicko ime]\Favorites. (Ovo je lokacija

u Windowsu XP; ona moZe biti drugacija na vasSem rac¢unaru.) Ukoliko imate
poddirektorijum pod imenom AutoCAD, pritisnite ga dvaput miSem kako biste
u njega snimili crtez. Obic¢no ovaj direktorijum sadrzi samo precice do dato-
teka koje su na drugim mestima. Da biste stavili preCicu do ve¢ snimljenog
crteza u direktorijum Favorites, odaberite File = Save As i pritisnite padaju¢u
listu Tools; potom pritisnite opciju Add to Favorites. Kasnije moZete otvoriti
datoteku iz direktorijuma Favorites.

FTP predstavlja skup lokacija na Internetu koje sluZe za razmenu datoteka.
Kada odaberete FTP, dobicete listu FTP lokacija koje ste sami dodali listi. Da
biste dodali lokacije FTP-u iz menija okvira za dijalog Save Drawing As, odabe-
rite Tools = Add/Modify FTP Locations. Ako se prijavljujete kao User, nave-
dite ime FTP lokacije, odaberite tip pristupa (Anonymous ili User) i navedite
svoje korisnicko ime i lozinku. Tada moZete snimiti crtez (Sto se zove slanje,
engl. uploading) na FTP lokaciju. Ova opcija €ini intranet ili bilo koji server sa
opcijom FTP pristupa¢nim u istoj meri kao i va$ ku¢ni racunar.

Desktop prikazuje crteze na radnoj povrsini. Neke od Windowsovih ikonica
se takode pojavljuju na ovoj listi.

Buzzsaw vas Salje na adresu www.buzzsaw.com na Internetu. Ova adresa pred-
stavlja Autodeskovu vezu s gradevinskim dizajnom i branSom. Tu moZete
otvoriti nov nalog ili pristupiti postojec¢im projektima.

Uz malo truda, dugmad na traci mogu se drugacije rasporediti. Samo povucite dugme na
novu lokaciju.

Lokaciju za snimanje datoteke moguce je odabrati i s padajuce liste Save In.
Onda unesite ime datoteke u polje File Name i pritisnite opciju Save kako biste sni-
mili datoteku.

U padajucoj listi Views moZete zadati kako Zelite da prikazujete datoteke u ovom
okviru za dijalog. Opcija List prikazuje imena datoteka; opcija Details dodaje i veli-
Cinu, tip i datum poslednje izmene sadrzaja datoteke uz njeno ime; opcija Preview
dodaje i uvodni prikaz crteza.

Komanda SAVEALL alatki Express snima sve otvorene crteZe, a da ih pri tom ne zatvara.
Ako crtez nije snimljen, od vas se traZi da mu navedete ime. Izaberite Express = File tools
> Save All Drawings. Informacije o instaliranju alatki Express mozete naci u dodatku A na
CD-u.

Veiba: snimanje crteia po prvi put
1. Pravougaonik koji ste u ovom poglavlju nacrtali trebalo bi da je jo§ uvek na

ekranu. Na standardnoj paleti alatki pritisnite dugme Save.
Otvorice se okvir za dijalog Save Drawing As.
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2. Pritisnite padajucu listu Save In. Ako treba, odaberite disk na kome se nalazi
nov direktorijum AutoCAD Biblija.

3. Pritisnite dvaput direktorijum koji ste napravili za rad uz ovu knjigu. Mozda
cete morati da pretrazite listu da biste dosli do imena direktorijuma.

4. U polju File Name odaberite ime datoteke. UpiSite ab01-1 i pritisnite taster
Enter (ili dugme Save).

AutoCAD ce snimiti crteZ pod imenom ab01-1.dwg. MoZete mu dati i neko drugo
ime, ali ¢e vam predloZeno ime pomoci da bolje organizujete crteZe iz ove knjige. Ono
oznacava da je u pitanju prvi crtez iz prvog poglavlja knjige AutoCAD 2004 Biblija.

Na CD-u Na kompakt disku se nalazi mali program, savea.lsp, koji automatski pravi rezervnu
L kopiju crteza na disketi ¢im ga snimite na disk. Ako ste navikli da zbog sigurnosti odmah
kopirate datoteke na disketu, ovaj program ¢e vam biti od koristi. PotraZite ga u direktori-

jumu \Software\Chap01l\Savea.

Zatvaranje crteza i izlazak iz AutoCAD-a
CrteZ moZete zatvoriti a da AutoCAD i dalje radi. To ¢ete najjednostavnije uciniti
ako pritisnete dugme Close, smeSteno neposredno ispod dugmeta za zatvaranje
aplikacije. MoZete odabrati i komandu File => Close.

Ukoliko hocete da zatvorite sve otvorene crteZe, odaberite Window = Close All. Ako niste
snimili neke izmene, AutoCAD (e vas podsetiti da to uradite. Ukoliko ste instalirali alatke
Express (pogledajte dodatak A na CD-u), moZete izabrati Express > File Tools => Quick Exit,
pa cete zatvoriti sve otvorene crteZe (uz prethodno snimanje izmena, prema potrebi) i
napustiti AutoCAD. Takode, moZete izabrati opciju menija Express = File tools => Close All
Drawings da biste zatvorili sve crteze bez napustanja AutoCAD-a, a prethodno ce vas
AutoCAD pitati da li Zelite da snimite izmene.

Savet

Da biste izasli iz AutoCAD-a, pritisnite dugme za zatvaranje aplikacije u gornjem
desnom uglu ekrana. Iz AutoCAD-a éete izaci i onda kada na komandnu liniju upisete
quit i pritisnete Enter. MoZete da odaberete i komandu File > Exit.

[

Novl Ako ste komandu ispisali samo do pola, crteze mozete zatvoriti i ako komandu ne zavrsite.

Sgptiina Ako ste nakon poslednjeg snimanja u crteZ uneli izmene, AutoCAD ¢e vas upitati
dali Zelite da ih snimite. Odgovorite potvrdno ili odre¢no, u zavisnosti od situacije.
Ukoliko odaberete Cancel, vrati¢ete se u crtez. Ako ste izmene unosili u viSe istovre-
meno otvorenih crteza, AutoCAD ce vas pitati redom za svaki od njih kako ne biste
napustili AutoCAD a da ne snimite sve izmene koje ste napravili u otvorenim

crteZima.

Veiba: zatvaranje crteza i izlazak iz AutoCAD-a

1. Trebalo bi da je pravougaonik ab01-1.dwg joS uvek na ekranu. Zadajte
komandu File => Close. Ugledacete siv ekran bez crteza. (Ponovite postupak
ako imate viSe otvorenih crteza. Snimite ili poniStite snimanje izmena u ovim
dodatno otvorenim crteZima, prema nahodenju.)

2. Pritisnite dugme za zatvaranje programa u gornjem desnom uglu da biste
napustili AutoCAD. AutoCAD ce se odmah zatvoriti.
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- Sazetak

U poglavlju 1 upoznali ste se s prozorom AutoCAD-a i poceli da crtate. Naucili ste da
snimite crteZ. Stekli ste osnovu za celokupan rad sa AutoCAD-om.
U ovom poglavlju ste:

*

L 4
L 4
L 4
L 4

® 6 6 6 O o o

saznali kratku istoriju AutoCAD-a

upoznali neke naucne discipline u kojima se koristi AutoCAD

naucili kako da pokrenete AutoCAD

naucili kako da zapoc¢nete nov crtez

upoznali AutoCAD-ov interfejs i njegove razlicite delove, ukljucujuci povrsinu
za crtanje, ikonicu UCS, koncanice, menije i palete alatki, komandnu liniju i
statusnu traku

naucili kako da se pokrene komanda LINE preko komandne linije

naucili kako da se zavrsi komanda LINE

naucili kako da nacrtate pravougaonik navodeci X i Y koordinate

naucili kako da pokrenete komandu ZOOM upisujudi je na komandnu liniju
naucili kako da snimite crteZ po prvi put

naucili kako da zatvorite crtez

naucili kako da izadete iz AutoCAD-a.

MoZda u ovom trenutku imate viSe pitanja, ali ,dobar pocetak je pola posla“.
U narednom poglavlju objasnjavam sve nacine na koje moZete da otvorite nov
crtez, kao i to kako da otvorite postojeci crtez.
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